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1. INTRODUCTION TO MONOCHROME

1.1. This is at least the third presentation on this topic since I have been with 
the Camera Club.  I did one probably in 2019.  And I found the outline in our 
on-line resources under Advanced Post Processing for one Neil did on black & 
white photography at some point.  So, bear with me if you have heard some of 
this before.  

1.2. Outline of Presentation.  I will be sending a PDF of my outline for this 
presentation to Glenn, who will post it on the Club Website.  The outline will 
contain more information and detail than I can present today.  In particular, in 
the outline I go into some detail regarding conversion of digital photos to 
monochrome in Lightroom Classic and Photoshop.  If you are interested, 
please take a look.  The outline also contains references to some of the 
materials I used in preparing the presentation. 

1.3. Basics Today.  You all know what a monochrome image is.  Many of 
you have substantial experience shooting black & white film or converting 
digital color images to black & white.  Today, I’m going back to basics on 
monochrome.  I hope all will learn something, even if it is only a nugget or 
two for the more experienced. 

1.4. What is it?  Monochrome means, literally, one color.  In photography, 
that is a photograph developed or executed in varying tones of only one color. 
If that color is gray, we call the image “black & white,” although because a 
black & white image will usually contain many more tones that just black and 
white, a more accurate term is “grayscale.”  But the single color need not be 
gray.  In analog photography, sepia, selenium and other toned images result 
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from using various toners as part of the printing process.  Cyanotype 
photography results in blue and white images without using a camera.  These 
color effects can be mimicked to some extent during digital processing.  And a 
digital monochrome image can be any color.  Again, what is monochrome:  to 
paraphrase Justice Potter Stewart, we all know a monochromatic image when 
we see one. 

1.5. Examples.  Here are some examples of monochrome images from the 
internet.  

1.6. Why monochrome? 

1.6.1. I went back through some of my photos to find monochromes so I 
could determine why I had created them.  I determined that my primary 
reasons for conversion were in three categories:  (a) photos of old time 
equipment and buildings (particularly railroad equipment and structures) 
that were around when most photography was with black and white film 
seem appropriate in grayscale or sepia; (b) I liked the way monochrome 
rendered the patterns and contrasts in the photo; or (c) I needed a photo to 
convert for demo purposes.  

1.6.2. I’m sure if you look on the internet, you can find many reasons for 
monochrome.  Neil’s outline in the Camera Club resources gives several.  I 
will just leave it at:  Try it.  You might like it.  

2. WAYS TO CREATE MONOCHROMATIC IMAGES

2.1. Use black & white film in a film camera.

2.2. Use in-camera monochrome settings with a digital camera.

2.3. Convert a digital color image to a monochrome image. 

2.4. Photograph a naturally monochromatic scene. 

2.5. Create a cyanotype photograph without a camera.

2.6. Use black & white infrared film or a digital camera converted to take 
infrared photos.  This last one is way beyond the scope of what I can cover 
today (but if anyone is interested, that could be a topic for the future).

3. BLACK & WHITE FILM
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3.1. Yes, it is still available.  B&H has 111 entries for 35mm black & white 
film.  And of course it comes in other sizes as well.

3.2. Probably many or all of us did at least some black & white film shooting
back in the day.  And probably still have film cameras and some old black & 
white film hidden in the refrigerator?

3.3. Now, decidedly a niche.  Let me know if you wish to explore further.  
We can all get out our film cameras, buy some film and give it a go.  And 
figure out how to get the images processed and printed (or processed, digitized
and printed).

4. IN-CAMERA DIGITAL MONOCHROME IMAGES

4.1. Most digital cameras have settings to take monochrome images.

4.2. My OM Systems OM-1 lets me select “Monochrome” as my Picture 
Mode and set sharpness, contrast, color filter (none, yellow, orange, red or 
green), monochrome color (none, sepia, blue, purple or green) and gradation 
(auto, normal, high key or low key).  

4.3. My Canon 5D MkIV has basically the same monochrome choices as the 
OM-1. 

4.4. To play with this approach, I bought a bouquet at Safeway, put it in a 
vase against the blue sky and took some snaps.  Here is what they look like.

4.4.1. Picture Mode Natural 3

4.4.2. Picture Mode Monochrome, No Filter, No Color

4.4.3. Picture Mode Monochrome, Yellow Filter, No Color

4.4.4. Etc.

4.4.5. Picture Mode Monochrome, No Filter, Sepia

4.4.6. Etc.

4.5. If you wish to try this, check out your camera manual or third party 
reference book to learn how.  Play with the various filters and toning effects.

4.6. One caution:  if you normally shoot in RAW, if you shoot in 
monochrome and then load the monochrome raw images into Lightroom, after 
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a few seconds or when you take the photos to the Develop Module, you may 
be surprised to find that your images are in color.

4.6.1. Here is a snap of a top down view of some flowers in a vase on our 
patio.  I had set the Picture Mode to Monochrome, no sharpness or contrast 
adjustments, a green filter to darken the reds, no color added and a high key
gradation.  The RAW I got when I imported it into Lightroom and went to 
the Develop Module is in color.

4.6.2. The problem is that Lightroom sees the raw image and applies the 
usual Adobe Color profile to it when you take it to the Develop Module. 
You could switch to the Adobe Monochrome profile.  Or to one of the 
Camera Matching profiles.  For example, in the case of the flowers I can 
switch to Adobe’s Camera Matching Monochrome with the Green filter 
applied.  But I don’t have an exact match for the combination of sharpness, 
contrast, color filter, monochrome color and gradation that I selected in 
camera.  Note:  You will also get Adobe’s Camera Matching profile if you 
have set your import in Lightroom Classic to “Camera Settings.”  (In 
Windows, that’s Edit > Preferences > Presets > Raw Defaults > Global > 
Camera Settings – instead of  Adobe Default).  Again, this won’t exactly 
match all the parameters you set n the camera.

4.6.3. Two ways to avoid this issue:

4.6.3.1. Set your camera to RAW plus JPEG before your monochrome 
shoot.  Then the JPEGs should be exactly what you set in-camera.  And 
you will have the RAWs to adjust any way you want.

4.6.3.2. Use your camera manufacturer’s photo processing software to 
view the RAW image.  The software should display the embedded JPEG
in the raw file that exactly captures all of the in-camera settings.  You 
should then be able to export that to a JPEG (or other file type) so that 
you have the in-camera settings in a separate non-RAW file.  Side by 
side, the two JPEGs are nearly identical.

5. CONVERTING A DIGITAL COLOR IMAGE TO MONOCHROME

5.1. Conversion of a digital image is the way most of us now are going to 
end up with monochrome images.  If you haven’t already, give this a try.  
Many color images look great in grayscale (or other monochrome). 
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5.2. Apps for Converting Images

5.2.1. I suspect that all photo processing software applications have at least 
one way, and perhaps multiple ways, to convert an image.  Here we see a 
screenshot from Lightroom Classic and a conversion using Luminar Neo.

5.2.2. In addition, there are conversion plug-ins that one can use for 
conversion.  NIK collection Silver Efex Pro is an example.  I don’t own the 
current version, or even the last one, but in past years I have used the free 
version most of us had or have.  Here is the same shot that I converted 
several years ago using the Ruth preset in Silver Efex Pro.  Likewise, many 
of us own Topaz Studio 2, which has ways to do grayscale conversions.

5.2.3. Today, I will demonstrate one conversion method in Lightroom 
Classic. 

5.2.4. The Presentation Outline discusses two additional conversion 
methods in Lightroom Classic and conversion in Photoshop.

5.2.5. If you use other apps for processing, check yours out to see how to 
do conversions.  

5.3. Here are the basic steps for converting a photo to monochrome.  This 
conversion used one of three methods in Lightroom Classic.  These steps 
should be generally applicable to conversion, regardless of the app used:

5.3.1. STEP ONE:  Select a photo you want to see in monochrome.  Here is
a snapshot I took outside my front door in October of last year for our “fall 
colors” theme in the club where I live now.  Its only virtue for this 
demonstration is the red tree and roof, green tree and grass and blue sky.

5.3.2. STEP TWO:  Process the photo in color, regardless whether you want
a color version of the photo.  Process it as you would normally process any 
photo.  However, you probably want to omit any watermarks or vignettes at
this point (if you have already processed the photo, copy your final color 
photo and delete your watermark and vignette, if any).  Here I have done 
basic Lightroom Classic processing, sharpened the image in Topaz Photo 
AI, sent it to Photoshop to remove the electrical boxes at the bottom, 
remove a tree branch, brighten the red tree, made the green tree greener and
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added some contrast and saturation to the sky.  And probably some other 
stuff.  

5.3.3. STEP THREE:  Convert the photo to grayscale using whichever app 
or plugin you prefer.  Here I used Lightroom Classic Method One for 
conversion, which is to simply to apply the Adobe Monochrome profile 
instead of the Adobe Color (or other) profile.

5.3.4. STEP FOUR: Adjust the tones in the converted photo to realize your 
visualization.  Here I have used the targeted adjustment tool (“TAT”) in the 
B&W Tab to lighten the green tree, darken the red tree, darken the blue sky 
and otherwise make minor tonal adjustments.

5.3.5. STEP FIVE:  Change the grayscale to another color if desired.  Here 
I used the Color Grading Tab to apply a fake looking sepia tone to the 
image.

5.3.6. STEP SIX:  Add any vignette and watermark if desired.

5.4. Points to Remember When Converting to Grayscale

5.4.1. Don’t simply desaturate.

5.4.1.1. In converting to grayscale, we are not just eliminating color.  If 
we simply desaturate a color photo, it will be grayscale, but not 
necessarily very appealing.

5.4.1.2. If we simply desaturate, if two colors in the image reflect the 
same amount of light, they will be indistinguishable in the grayscale 
image.  

5.4.1.3. If we desaturate in Lightroom Classic, we still have the Color 
Mixer Tab, but moving the sliders does nothing, because there is no 
underlying color left in the image.

5.4.2. Map colors to tones.

5.4.2.1. Instead of desaturation, think of conversion to grayscale as 
converting (or mapping) colors to tones.

5.4.2.2. When you do a conversion, you are making a subjective decision 
of how each color will be shown as a discrete shade along the black to 
white continuum.
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5.4.2.3. Keep in mind that there is no “correct” way to do the conversion.  
The important thing is realizing your vision for the resulting image.

5.4.2.4. Also keep in mind that color remains essential to the conversion 
process.  Remember that you are mapping different colors to different 
tones to achieve separation.

5.4.3. Presets versus Sliders.  Regardless of the app you use for conversion,
when you convert, the app is using a profile or preset that determines the 
tonal value that is assigned to each color in the image.  And you might like 
the result and be done.  However, look for ways to change the tonal values 
after conversion so that the final image matches your visualization of the 
image.  I call this “presets versus sliders” but the “preset” can be a preset, 
profile, black and white conversion layer, gradient map or any other means 
of converting.  On the other hand. “slider” refers to any means to alter the 
tones post conversion, whether actual sliders, targeted adjustment tools, 
adjustment layers, etc.

5.4.4. Digital Filters

5.4.4.1. Basically, in doing the conversion, we are using digital filters that 
allow colors to pass through in differing degrees.
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5.4.4.2. Filters pass most of the light that is the same color as the filter and
block to the highest degree colors that are opposite of the filter color on 
a color wheel.  

5.4.5. Avoid Artifacts

5.4.5.1. To avoid artifacts such as banding and posterization, it is even 
more important when converting an image to grayscale to work in 16 bit
format. Inside Lightroom Classic, editing is done in a large color space 
that Lightroom manages.  Check your settings in Lightroom Classic to 
make sure that you are set to send your images to Photoshop or another 
external editor in the ProPhoto RGB or Adobe RGB (1998) color space 
and with a 16 bits per component bit depth.  If you work in another 
editor, again that you are working in a large color space and at a 16 bits 
per component bit depth.   

6. OTHER MONOCHROMES

6.1. Toned Prints

6.1.1. As previously mentioned, in analog photography monochrome prints 
can be made in colors other than grayscale.  These colors are generally 
referred to as “tones” because the color results from using a particular toner
or toners during the wet processing of the photo.

6.1.2. These colors (tones) include sepia, selenium, gold and others.

6.1.3. Sepia  

6.1.3.1. Sepia is a brown toner that can be used while making a darkroom 
print.  In chemical processing, grayscale photos generally contain 
metallic silver.  In the sepia process, silver sulphide replaces the metallic
silver resulting in the brownish toned photographs.

6.1.3.2. The color sepia gets its name from ink made from the cuttlefish 
named “sepia.”  

6.1.4. Selenium
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6.1.4.1. Selenium toner will react with the silver in the print emulsion to 
form silver selenide.

6.1.4.2. Selenium toners are said to work from the bottom up, that is dark 
tones are affected sooner than light tones, so the effect depends on the 
time the print is left in the toner.

6.1.4.3. In addition, the effects will differ with the dilution of the toner 
(the ratio of toner to water) and the paper used to make the print.

6.2. Digital Re-creation of Toner Effects

6.2.1. As we have seen, in digital photography, a sepia effect can be 
obtained in a couple of ways

6.2.1.1.   By shooting with the monochrome picture style with the color 
set to sepia.

6.2.1.2.   By selecting a sepia preset in Lightroom or other software when 
converting a color photo to monochrome.

6.2.1.3.   In Photoshop or other software that supports layers, by adding a 
solid color adjustment layer set to sepia after conversion is otherwise 
completed and reducing the opacity of the layer to a suitable percentage 
(try around 30%).  Sepia can be obtained with RGB values of R=112, 
G=66 and B=20 (Hex Code #704214).

6.2.2. Similarly, selenium effects can be done digitally, but the complexities
of the selenium toning process make the digital equivalents more varied and
complex.  One website offers Photoshop actions for selenium (and other) 
effects for a mere $100.  If you are interested, see the References.

6.3. Cyanotypes

6.3.1. In 1842, Sir John Herschel created the first cyanotype by coating 
paper with iron salts, putting an object on the paper, exposing it to the sun 
and then washing the exposed paper with water.  The result was a white 
image on a deep blue background.

6.3.2. Herschel used this printing process to copy and preserve his notes 
and diagrams.  This is the same basic process used to make blueprints.
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6.3.3. Anna Atkins used Hershel’s process to produce the first book with 
photographic illustrations.  Her first book, Photographs of British Algae: 
Cyanotype Impressions, came in 1843 and was followed with two 
additional volumes.  

6.3.4. The cyanotype process: 

6.3.4.1. Mix ferric ammonium citrate or ferric ammonium oxalate with 
potassium ferricyanide to make a solution sensitive to UV light.

6.3.4.2. Paint the solution onto paper or fabric and leave it to dry in a dark 
room. 

6.3.4.3. Arrange objects onto the paper and place it in direct sunlight.

6.3.4.4. The UV rays from the sun react with the chemicals on the paper to
create a blue background.  Objects on the paper block the sunlight, 
leaving the paper beneath white.

6.3.4.5. Rinse the chemicals off the paper with water.  This fixes the print 
so that it is no longer sensitive to sunlight. 

6.3.5. You can make cyanotypes at home.  See the References for the 
procedure and sources of materials.

6.3.6. Digital cyanotype effects. 

6.3.6.1.  This maple leaf is my attempt to recreate the cyanotype effect 
digitally.  I snapped a photo of a maple leaf on the pavement in a 
parking lot at Yosemite with my phone, then played with it to create this 
photo.  Obviously, I have a ways to go.  Getting the color right is 
probably the easiest.  

7. ADDENDUM ONE:  CONVERSION IN LIGHTROOM CLASSIC

7.1. Introduction

7.1.1. These conversion methods should apply equally to Adobe Camera 
Raw.  The controls may be in different places, but everything should work 
the same.  These methods may also work in Lightroom (web version), but I 
haven’t tried them.

7.1.2. Start With Raw Photo:  For best results, start from raw photos.  If you
start from a rendered photo (for example, a JPEG or TIF), you will have 
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different options and the following methods won’t necessarily work.  But, 
heh, you shoot in raw anyway (don’t you?).

7.1.3. Don’t do in Lightroom.  Don’t simply remove saturation using the 
saturation sliders under the Color Mixer Tab (what used to be the HSL Tab).
If you do, the various colors will be mapped to muddy tones in the 
desaturated grayscale.

7.1.4. Do in Lightroom:

7.1.4.1.  Process in Lightroom Classic (and Photoshop or other software) 
as you would any color photo.  For example

7.1.4.1.1.  Choose the Adobe Color Profile

7.1.4.1.2.  Try “Auto” to see what Adobe thinks should be done to the 
photo.

7.1.4.1.3.  Set your White Balance as appropriate.  I tend to shoot with 
auto white balance, but mucking around can help.  Try the eye 
dropper if you have an even light tone to sample.

7.1.4.1.4. Check for clipping and move White and Black points to 
eliminate.

7.1.4.1.5.  I always like to change the Tone Curve to Medium or 
sometimes Strong Contrast.

7.1.4.1.6.  Use the Calibration Tab to separate your colors.  Increasing 
the blue saturation always gives a bit of a pop to colors in landscape 
photos.  Play with the red saturation and green hue (to make the 
greens more green than yellow) for the fun of it.

7.1.4.1.7.  Play in the Color Mixer Tab.  Use either the Mixer or the 
Point Color.  

7.1.4.2. Convert the finished color image to grayscale using one of the 
three methods discussed below.

7.2. Method One – Select the Basic Monochrome Profile

7.2.1. In the Develop Module, at the top of the Basic Tab, choose “B & W.”
Notice that just below, the Profile changes from “Adobe Color” to “Adobe 
Monochrome.”  (Alternatively, under the Profile dropdown, click Browse > 
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Adobe Raw > and choose the Adobe Monochrome Profile and click Close. 
Notice at the top of the Basic Tab, we are now in B&W.  Two ways to get to
the same Adobe Monochrome Profile).

7.2.2. Using either method of selecting the Adobe Monochrome Profile, 
you now have a grayscale image. 

7.2.3. Instead of the Color Mixer Tab, you have a B&W Tab.

7.2.4. Under the B&W Tab, you can adjust the individual colors using the 
sliders or the Targeted Adjustment Tool (“TAT”) (click on the tool, then find
color in photo, left click and move up or down to adjust.  

7.3. Method Two – Select one of the Black & White Profiles

7.3.1. In the Develop Module, under the Basic Tab, use the Profile 
dropdown and click Browse or click the four boxes on the right of Profile.  
In either case, drop down to the 17 B & W profiles and choose one of 
Adobe’s 12 B & W profiles or one of the 5 color filter profiles.

7.3.2. Close the Profile selector.  You now have a grayscale image based on 
the profile you have selected.  

7.3.3. As with the Basic Monochrome Profile, you now have a B & W Tab 
(instead of the Color Mixer Tab) where you can further adjust the individual
colors with the TAT or sliders.  

7.3.4. Note:  There may also be “Camera Matching” Profiles available, 
including one or more Monochrome Camera Matching profiles (depending 
on your camera).  It is my understanding that these don’t exactly match the 
camera profiles from the camera manufacturer, because Adobe doesn’t have
access to those profiles.  Instead, Adobe tries to come as close as it can to 
the profile the camera manufacturer assigns to the JPEG image embedded 
in your Raw file when you chose a picture style in your camera menu.  
Note that you likely will NOT have the B&W tab available to you if you 
choose a Monochrome Camera Matching Profile so you will not be able to 
make further adjustments to the tones of individual colors.  Trying to open 
the Color Mixer Tab gives a warning “Monochrome profile applied.” So, in 
most cases using a Black & White Profile (see above) will be preferable.

7.4. Method Three – Select a Black & White Preset
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7.4.1. In the Develop Module under the Basic Tab, don’t change anything 
yet and go to “Presets” on the left panel.

7.4.2. There are black & white presets in three areas here:  “Portraits: Black
& White;” “Style: Black & White;” and “B&W.”

7.4.3. See the change to your image as you hover your mouse over the 
various presets.  

7.4.4. Pick a preset to apply it. 

7.4.5. Now, see what has happened in the right panel:

7.4.5.1. The Profile is now either Adobe Monochrome (if you choose a 
Portraits: Black & White or Style: Black & White Preset) or a specific 
black & white profile (if you choose a B&W Preset);

7.4.5.2. The sliders in the Basic Tab will have moved; and

7.4.5.3. The sliders in the Black & White Tab will have moved.

7.4.6. You still have some leeway to further adjust the tone sliders in the 
Basic Tab and color sliders in the B & W Tab.  Note that using a preset will 
always make the initial processing easier while reducing your control and 
creativity in making the final image.

7.4.7. Three presets under the B&W presets (Selenium, Sepia or Split Tone)
as well as some of the presets under Portraits: Black & White or Style: 
Black & White will produce non-grayscale monochrome images.  

8.  ADDENDUM TWO: CONVERSION IN PHOTOSHOP

8.1. Introduction

8.1.1. Photoshop Don’t Number One:  As with Lightroom, don’t simply add
an HSL Adjustment Layer and then move the master saturation slider (or 
the individual color sliders) to minus 100.  The result will be grayscale, but 
there will be no separation of the underlying colors. 

8.1.2. Photoshop Don’t Number Two:  Don’t change the mode of the image 
to grayscale (Image > Mode > Grayscale).  Here you even get a warning:  
“Discard color information?”  We need the underlying color information in 
our image for our grayscale conversion, so we certainly don’t want to 
discard it.   

2024-03-06 SCSH CC 
Presentation - Monochrome - 
Outline and Resources-Final for 
Posting.odt
03/08/24

Page 13 of 17



8.2. Conversion in Photoshop using a Black & White Adjustment Layer:

8.2.1. Open the photo in Photoshop

8.2.2. Do any cleanup work that you omitted in Lightroom because it was 
too much bother.

8.2.3. Add a Black & White Adjustment Layer (use the TK9 plug in panel if
you have it)

8.2.4. If the Properties Panel isn’t open, open it (Window > Properties; 
move it where you want it).

8.2.4.1. You can now click the “auto” button to see what Photoshop thinks
your image needs.

8.2.5. Or, under “preset” you can pick either “Default” or one of the color 
or other filters under the drop down menu.   Unlike Lightroom, you must 
select a preset to see what it looks like, rather than just hovering your 
mouse.

8.2.6. Use the sliders or the Targeted Adjustment Tool to further adjust 
colors.

8.2.7. Notice that in Photoshop, we have the option to apply a mask to our 
Black & White Adjustment Layer so that our conversion covers only a 
portion of the photo.   For example, if we add a white mask, then paint on 
the mask with a black brush at 100% opacity, the areas we paint retain their 
color.

8.2.8. Or, we can mask off portions of the image and use multiple Black & 
White Adjustment Layers to convert areas with different adjustments (for 
example, converting the sky and landscape differently).

8.2.9. And, we have all the other Photoshop tools (curves, levels, etc.) to 
make further adjustments.

8.3. Conversion in Photoshop Using a Black to White Gradient Map

8.3.1. Blake Rudis has come up with a Photoshop conversion that uses a 
Black to White Gradient Map instead of a Black & White Adjustment 
Layer.  
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8.3.2. I first saw this in the Blake Rudis (f64 Academy) YouTube video 
listed in the References, below.

8.3.3. Blake refined this and provided a Photoshop Action in Lesson 13 of 
his new Gradients Course.

8.3.4. Blake converts with:

8.3.4.1. A black to white gradient for the conversion at the top of the layer
stack; 

8.3.4.2. Three color adjustment layers under the gradient to control the 
underlying colors

8.3.4.2.1.  An HSL Adjustment Layer to shift colors;

8.3.4.2.2.  A Selective Color Adjustment Layer to refine colors; and

8.3.4.2.3.  A Color Balance Adjustment Layer to balance colors.

8.3.4.3. The refinement Blake added in his new Gradients Course is to add
a Curves Adjustment Layer above the Gradient Map layer and clip it to 
the Gradient Map Layer.

8.3.5. Blake gives you a Photoshop action that you can download to easily 
add all four layers to your layer stack.

8.3.6. I haven’t studied Blake’s method in detail, but trying it on a few 
photos, it appears to give much more control over the single Black & White
Adjustment Layer method.

9. RESOURCES
9.1. General:

9.1.1. Google Search “Monochrome” resulting in Google Oxford 
Languages definition   https://www.google.com/search?
channel=ftr&client=firefox-b-1-d&q=monochrome   

9.1.2. Wikipedia Article, Monochrome:  
https://en.wikipedia.org/wiki/Monochrome  

9.1.3. Expert Photography web article:  Monochrome Photography vs 
Black and White (Difference?)  
https://expertphotography.com/monochrome-vs-black-and-white-
photography/  

9.2. Lightroom:
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9.2.1. Alister Benn – Expressive Photography YouTube – Landscape 
Photography: How to process magical black and white images from fall 
colour. -  https://www.youtube.com/watch?
v=_smdnzfpdys&list=PLusthZgTzTIxPb4-ux6Mhxpo2gO-
QEwwQ&index=30 

9.2.2. Alister Benn – Expressive Photography YouTube – How to Perfect 
Black & White Landscapes Without Presets (1st in series) - 
https://www.youtube.com/watch?v=w0kymyxNCPA&t=29s  

9.2.3. Alister Benn – Expressive Photography YouTube – Creative Black 
and White landscape Photography in Adobe Lightroom (2nd in series) 
https://www.youtube.com/watch?
v=HXQHHRhor3o&list=PLusthZgTzTIz8uGtUIT-S-
SFULLEQvY8C&index=9  

9.2.4. Anthony Morganti YouTube – Ten Steps to Black & White in 
LIGHTROOM: https://www.youtube.com/watch?v=_xM6hq2TxOI  

9.2.5. Adorama TV – 7 Step Advanced Black & White Editing in 
Lightroom: https://www.youtube.com/watch?v=itw37I51LAg  

9.2.6. Serge Ramelli YouTube – From Boring to Dramatic black and white 
in Lightroom 2021:  https://www.youtube.com/watch?v=158-ZU_53KY 

9.3. Photoshop:
9.3.1. Guy Tal, The Landscape Photographer’s Guide to Photoshop, 

RockyNook, 2018, pp 209-225.
9.3.2. Blake Rudis You Tube – Foolproof 4 Step Black and White Photos! 

https://www.youtube.com/watch?v=aSS1LU3yTDY 
9.3.3. Blake Rudis Course – Beyond Colors (New Gradient Course), 

Lesson 13, Gradient Map BW.
9.3.4. Joel Grimes YouTube - The Ultimate black & white conversion for a 

Dramatic look     https://www.youtube.com/watch?v=z4HYksU_7Tg  
9.4. Print Toning and Digital 

9.4.1. General:
9.4.1.1. Wikipedia Article, Photographic Print Toning:  

https://en.wikipedia.org/wiki/Photographic_print_toning  
9.4.2. Sepia:

9.4.2.1. Photokonnexion – Sepia Definition 
https://www.photokonnexion.com/definition-sepia/   
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9.4.2.2.   
9.4.3. Selenium:

9.4.3.1.   J Connelly, Selenium Toning: 
https://jasonconnelly.wordpress.com/2020/06/28/selenium-toning/  

9.4.3.2.   Gavin Seim, Selenium Toning on Digital Photos is very cool!: 
https://seimeffects.com/2022/09/02/selenium-toning-bath-digital/  

9.4.3.3. Gavin Seim,  Emulsion 4:   https://seimeffects.com/signature  
9.5. Cyanotypes:

9.5.1.  Laura Bagnall for Kew Gardens, Cyanotypes: The origins of 
photography:  https://www.kew.org/read-and-watch/cyanotype-photography

9.5.2. Wikipedia Article, Cyanotype: 
https://en.wikipedia.org/wiki/Cyanotype  
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